
 

 

 

 

Objectives 
 

This unit provides a quick overview of the functionality of Microsoft Word 2002. MS-Word is 
the word processor of the MS-Office XP productivity software suite. The emphasis in this unit 
is on giving an overview of the basic knowledge required to work productively with Word, 
rather than a detailed step-by-step introductory tutorial. On the other hand, there is so much 
functionality in Word that it is outside the scope of this overview to deal in depth with the 
more advanced topics. It is, in our view, better to learn about the advanced features as your 
experience grows and you develop a particular need for a specific functionality such as mail 
merge, collaborative document development, tables with calculations, VBA automation or 
web/XML integration. 

After working your way through this module, you should be able to: 

• Understand the basic concepts of word processing and the screen layout of Word. 

• Create, load, save and print your document. 

• Enter, edit and format text. 

• Incorporate tables, clip-art and graphics in your document. 

• Use the grammar and spelling tools to assist with proofing your document. 

 

 

 

 



2  Quick Start to Word 2002 

Introduction to MS-Word 
Welcome to Microsoft Word 2002, which is one of most powerful and widely used word 
processing programs? Whether you want to type a simple letter or produce a complex book, 
Word can handle the job for you. These notes are only intended to get you going with the 
basic operation of Word. Books of several hundreds of pages have been devoted to the "ins" 
and "outs" of Word and even the most experienced Word users keep discovering new capa-
bilities, features or possibilities. We just aim to give you sufficient confidence to type simple 
documents such as essays and projects. As you start using Word, you will discover new fea-
tures as you go along. Do not be afraid to experiment or share your experiences with your 
fellow students. 

What Is Word Processing? 
Word processing can be defined as the use of software to aid in the composition, revision, 
filing and printing of text. You are not limited to text, however, you can also edit graphics, 
clip-art, and word “art”. Why, your Word documents can even incorporate animation and 
sound! 

Some of the typical documents produced with Word include brochures, leaflets, reports, as-
signments, letters, memos, faxes, theses and even calendars. 
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Why Word Processing Instead of Using Typewriters? 
Today's word processing software has rendered the typewriter almost completely obsolete. 
The original purpose of a word processor was to produce simple printed documents such as 
business correspondence and small reports. Nowadays word processors (and printers) are 
used for all but the most demanding typesetting jobs including stunning full-colour produc-
tions and electronic publications. The following are just some of the advantages of word 
processing instead handwriting or typing. 

• Easy editing and re-use of (parts of) previously created documents. 

• Advanced graphic capabilities e.g. use of clip-art, drawings, pictures and “word art”. 

• Assistance of electronic dictionaries, thesauruses and grammar checkers. 

• Attractive layout elements are easily incorporated e.g. different fonts, borders, and wa-
termarks. 

• Automation of error-prone routines such as page numbering or constructing a table of 
contents. 

• Full integration with other productivity software (spreadsheets, databases, presenta-
tions). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



4  Quick Start to Word 2002 

Basic Word Processing Concepts 

Characters, Words and Paragraphs 
The smallest element with which you will work is the character. A character can be a letter, 
digit, punctuation symbol or any other symbol. Each letter can be formatted differently as in: 

 BU TE
R  

The format of text refers to the way it looks (e.g. bold, large) and where it is positioned (e.g. 
on the left).  

Several characters together make up a word. Words are separated by a blank <Space>.  

Words are grouped together in sentences. One or more sentences make up a paragraph. A 
paragraph is anything that ends with the <Return> or <Enter> -key. Paragraphs are a very 
important entity in word processors; they have their own special formatting characteristics 
such as alignment, line spacing, borders and indents. 

All your paragraphs together will constitute your document, which is normally saved in a 
single file. Very large documents may be split up in different files for convenience. 

As you type, a word processor will automatically move a word that does not fit at the end of 
the line to the beginning of the next line. This is called "wrap-around": you don't have to (and 
shouldn’t!) press the <Return>-key to indicate the end of a line and move to the next one.  

Document Layout: WYSIWYG? 
A word processor displays your document more or less in the same way as it will appear in 
printed form. The holy grail of word processing is "What-You-See-Is-What-You-Get" 
(WYSIWYG). Since a monitor does not have exactly the same characteristics as a printer, 
this may not always be the case. Coloured text on screen will print out as a shade of gray on 
a laser printer; fuzzy letters on your monitor will print out with sharp edges; what looks like a 
perfect picture may be far less clear on paper. When you change printers, the word proces-
sor may adjust the page layout if it “knows” that the printer cannot print beyond certain mar-
gins or uses a different size of paper. 
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Important Word Processing Rules 
There are a number of important rules with respect to word processing. If you are used to 
typewriters, you may want to take special note of these rules. 

• Never use the <Enter>-key to mark the end of a line. Your word processor will auto-
matically wrap-around to the next line. The <Enter>-key should only be used to end 
a paragraph. This is important because every time you change the page side mar-
gins or the font size, your lines will break at a different word. 

• If you want to align the beginning of a word or sentence at another place than the left 
margin, don’t use the <Space>-bar to insert the required blank space to visually align 
the text. This will result in a very ragged edge at best, or jumbled text at worst, when 
you make even the slightest change at a later stage (e.g. inserting a new word or 
changing the formatting). Aligning text is done using the <Tab>-key, paragraph in-
denting, or the table feature. 

• Save frequently and make regular backups of important documents on different 
disks. Even if you don’t make any drastic mistakes, a bug in the software may corrupt 
your entire document. No one that I know has ever adopted this rule before they’ve 
lost at least a solid week’s work. May you be the first! 

How to Get Additional Help 
Word 2002 comes with a very comprehensive help system. Use it! You can get on-line as-
sistance in one of the following ways. 

1. Hover the mouse cursor for 2 seconds above any icon and a small text box (screen tip) 
will explain its function. 

2. Use Microsoft Word’s Help function. Press the <F1> function 
key to search the help resource file on any specific topic. Select 
the Help menu (click on the menu option or press <Alt>-H) to 
display the various Help menu options, including an alphabeti-
cal index of all keywords and the contents organized in a logi-
cal way. 

3. Use one of the digital office assistants. They will look up any-
thing you want and even offer advice when they see a better 
way of doing things. Depending on your installation, you could 
have one of the following: Merlin or Clippit. 

 

  



6  Quick Start to Word 2002 

The Word 2002 Window Elements 
The editing window of Word can appear quite intimidating at first. It has indeed so many 
icons and options. But they are grouped together quite logically and consistently. A great 
advantage is that, once you have got used to the Word interface, working with other Win-
dows applications will go that much quicker. You find a typical MS-Word screen below. Your 

screen may differ slightly, depending on how your system is set up.  

Toolbars 

 

The toolbars have little icons or buttons that perform a variety of tasks. Just click the icon 
once to activate. If you are not quite sure what the button does, hover your cursor for two 
seconds above the button and a small explanatory text will appear. The screen above shows 
three toolbars: the standard toolbar (which you will find in all Office 2002 applications), the 
formatting toolbar (which contains the most used 
text formatting commands) and, at the bottom, the 
drawing toolbar. You can add or delete toolbars by 
right-clicking on any toolbar and selecting/de-
selecting from the pop-up list of possible toolbars. 
You can also move toolbars from top to bottom or 
turn them into “floating” toolbars by dragging them 
to the desired location. 

Toolbar 
Menu bar 

Ruler bar 

Ruler bar 

Toolbar 

Status Bar 

Scroll Bar 

Tool Bar 

Scroll Bar 

The Document Window 

Title bar and 
document name 

Task 
Pane 
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Menu bar 

 

All commands, including those not found on the toolbars, are available from the menus. 
Choose any menu by clicking the desired menu option or press the <Alt>-key in combination 
with the underlined letter of the menu option. For example, to access a File command, press 
<Alt>-F. 

Scroll bars 
 

 

The use of the scroll bars is explained in the “Quick Start to Win-
dows”. Note the special Previous/Next Page and Select Browse 
Object buttons on the vertical scroll bar.  

The larger your document, the smaller the slider inside your scroll 
bar becomes: its size indicates the size of the screen relative to the 
total size of your document. 

The Ruler Bars 

The horizontal and vertical ruler bars indicate the position of the text in relation to the current 
page: the white space indicates the text area and the gray area refers to the page margins. 
The numbers give the position in centimeters (or inches, depending on your preference). 
The ruler also provides you with a quick way to set Tabs: just double-click on the ruler where 
you want the new tab and right-click to set the type of tab or dot leader. You can also adjust 
your page margins and paragraph indent on the ruler bar. Remove the rulers from the win-
dows by selecting the View • Ruler menu option 

Different Document Views 
One of the main purposes of a Graphical User Interface operating 
system, such as Windows, is to ensure that “What-You-See-Is-
What-You-Get” a.k.a. WYSIWYG. Word 2002 tries to give you as 

close an approximation to the final printed product as possible. However, for editing pur-
poses, you may not always wish to see the exact same thing as the final print-out. Select the 
desired document view from the View menu or click its button on the left of the horizontal 
scroll bar. 

Normal: in this view, you see the main text area almost exactly the way the way it will be 
printed out, but it leaves out page formatting such as page margins, headers and footers. It 

Fast browse 

Browse option 
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also re-formats the document so that you can see as much text as possible within the win-
dow. 

Print Layout: shows you exactly how it will be printed out, 
including page numbers, headers, footers and page mar-
gins. This is the preferred view but may slow you down 
when working with a big document. 

Web Layout: shows roughly what it would look like if 
saved in HTML format and viewed by a web browser. 

Outline: does not show the actual text but just the various 
headings. Ideal if you want to see or modify the overall 
structure of your document. 

Full Screen: takes away all toolbars, rulers, menus and even the title bar so that you can 
see as much of your document on screen as possible. The only remain-
ing non-document item is the floating “Full Screen” window. Click on it to 
close the full screen and return back to the normal window view with all 
its toolbars. 

There are another two document view-related options available from the standard toolbar. 

Print Preview: gives you an exact view of how the printed page will look like. Select 
print preview by clicking the Print Preview Icon on the standard toolbar or selecting 
the Print Preview option from the File menu. 

Zoom factor: the percentage factor by which the screen should be enlarged 
(>100%) or reduced (<100%). You can specify this factor with the Zoom op-

tion of the View menu (see be-
low) or by using the drop box 
on the standard toolbar (see 
right). 
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Creating a New Document 
There are various ways of creating a Word document. 

How to Start Word 
If you click on an existing Word document file on the desktop or in Ex-
plorer, Windows will automatically load Word and open the document 
for you. You may also have the Create a New Document icon on your Windows 
desktop or on the Start menu.  

Alternatively, you can load Word directly from a desktop icon or from the Program Start 
menu. In the latter case, you will face a blank screen, which means you start creating a new 
document right away. The default name of your new document is Document1. When you 
save your document the first time, Word will prompt you for a new name. 

Starting with another Blank Document 
If you want to create another new document from scratch, you can click on the New 
Blank Document icon on the standard toolbar, select from the File menu or click 
Blank Document in the New Document task pane. This will open a second docu-
ment, with the default name of Document2. In fact, you can open as many docu-

ments as your system capacity will allow you to. Switch between your documents by using 
the Window menu or click on the window that contains the document you want. 

Starting from a Template 
Save yourself a lot of trouble and produce a much 
more professional-looking document by making 
use of the various templates that come packaged 
with Word. These are pre-formatted and provide 
clear directions where you have to provide the 
necessary information. 

To create a new document based on a template, select the New 
option under 
the File 
menu, or 
press the 
<Ctrl>-N 
shortcut key combination. This will 
open the New Document window list-
ing all templates. Or select one of the 
New from template options on the 
New Document task pane. 

Click on a tab to select 
the type of template 

Preview the 
template 

Select your 
template 

OK when 
done 
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Entering and Editing Text 

Entering, Deleting and Correcting Text 
As you type, the text gets entered into your document at the location of the text insertion 
cursor, which is a vertical bar. When you get to the end of a line, Word will automatically 
wrap-around to the next line. You should only press the <Enter>-key when you want to start 
a new paragraph. 

Use the <Del>-key to delete text to the right or <Back Space> to delete text to the left of the 
cursor.  

The cursor (or arrow) keys move the text insertion cursor around your document. You can 
also position the text cursor to where the mouse arrow cursor is located by clicking the left 
mouse button, as long as it is in the document window. 

Selecting Text 
To delete, move or copy a larger block of existing text, you must first select the text in one of 
the following ways. As you do so, the selected text will be highlighted in reverse, just like the 
current sentence.  

• Drag the mouse cursor from the beginning to the end of the text. 

• Move the text insertion cursor from the beginning to the end with the cursor keys while 
holding down the <Shift>-key. 

• Press the <F8>-key a number of times in quick succession: twice to select the word 
where the text insertion cursor is located, three times to select the entire sentence, four 
times to select the current paragraph or five times to select the entire document.  

Pressing the <Del>-key when text is selected, deletes it. Alternatively, start typing new text 
straight away.   

Copying and Moving Text 
You can use the clipboard to copy or move text. Use the clipboard icons, the shortcut keys 
or the Edit menu.  You can also drag selected text to a new position in your document. 

Moving within a Document 
You can move to another location in your document by using the arrow keys. If you want to 
move quicker, use the <Pg Dn> or <Pg Up> keys to move one paragraph at a time or 
<Ctrl>-<Pg Up> and <Ctrl>-<Pg Dn> to move you one screen at a time. The <Home> and 
<End> keys move you to the beginning or end of the line, whereas <Ctrl>-<Home> and 
<Ctrl>-<End> move you to the start or end of your document... 

You can also use the mouse to click on or drag the scroll bar. 
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Undoing Mistakes 
Word has a very powerful undo feature. If you delete something by accident or perform a 

command by mistake, you can undo the dam-
age and restore the document to its previous 
stage by using the undo feature. Click on the 
Undo button on the standard toolbar to undo your last ac-
tion (or press <Ctrl>-Z). If you want to undo more than 
one action, you can scroll through all the editing tasks you 
have done since loading the document by clicking on the 

adjacent drop-down button which lets you scroll through your various commands. You can 
selectively undo any one of them or undo a whole lot of them at once (illustrated). 

If you have undone an action and decide that you did want to take that action after all, 
click the Redo button. 

Note: also refer to the section on Tools for Word’s AutoCorrect, spell checking and gram-
mar checking. 
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last 
action 

Redo 

Undo all 
or any 
action(s) 
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Saving and Loading Your Document 
The procedure for saving a document is the same in most Windows applications. 

Saving and Naming a Document 
To save a document using the current document name, click the Save button on 
the standard toolbar or press the <Ctrl>-S keyboard shortcut. If you opened a new 
document and the name is still the default Document# name, you will be taken to 

the Save As … window. This window can also be used to save an existing document under 
a different name or as a different type: select the Save As option of the File menu.  

Loading an Existing Document 
To load an existing Word document if you are currently in Word, click the Open 
button on the standard toolbar; select the Open… option of the File menu, or use 
the <Ctrl>-O shortcut key. The Open File window will appear. Most elements on 

this window are similar those of the Save As window. 

The New Document task pane will list the most recently 
used documents. It also allows you to create a new docu-
ment based on the formatting of an existing document or us-
ing a template. The last few documents edited are also listed 
at the bottom of the File menu. 

 

Save on the 
desktop 

Click here to select 
another folder 

Favourite 
folders 

Create a 
new folder 

Specify how to 
list documents 

Click to save 

List of documents 

Specify new 
document name Save in a variety of formats e.g. 

to share with other word proc-
essors or for the Internet.  
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Using the Task Panes 
A major improvement of Office XP is the introduction of the task pane. A task pane is a 
small side window displaying the options for frequently used tasks. By default, the task pane 
takes up the righthand-side of the document window (see p.6). This is most convenient when 
working in full screen mode on a larger monitor where the width of your document leaves 
plenty of side space. Just like the toolbars, you can move the task pane to any location you 
want to by dragging the title bar to the desired screen location. (Move a toolbar by dragging 
its handle which is the leftmost vertical bar.) 

Word has 8 task panes, of which you are likely to use the 
New Document, Clipboard and the Styles and Formatting 
task panes most often – they are shown in their relevant sec-
tions. None of the task panes add functions to Word that is 
not available from the menus, but they make many tasks 
much quicker and easier. 

A relevant task pane pops up whenever Word thinks that you 
have the need for it. E.g. when launching Word it will open 
the New Document pane; when pasting from the clipboard, it 
will open up the extended Office XP clipboard pane; when 

changing paragraph styles it will give the styles pane  etc. You can select any one of the 
available task panes by clicking the drop-down button on the pane’s title bar.  

Below are examples of the search, reveal formatting and clipboard task panes. 
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 Character Formatting 
You have an extremely wide variety of formats that you can apply to your text. These for-
mats determine how a letter will look like: colour, shape, size etc. These formats are also 
called the attributes of the text. When you switch to a certain format, all the new text you 
type at that location will inherit the attributes that are currently “active”. When you move the 
cursor to another area, any new text you type will inherit the attributes from the surrounding 
(neighbouring) text. You can also select existing text and apply special formatting to it.   

Choosing a Font Type and Font Size 
One of the attractions of Windows-based word processors is the wide variety of fonts from 
which you can choose. The following are just some of the fonts that come standard with 
Windows XP. 

Arial  Arial Black   Book Antiqua   Britannic Bold    Comic Sans   Franklin Gothic   Gara-

mond   Haettenschweiler   Impact    Monotype Corsiva   Tahoma   Verdana   and of course Times New 
Roman.  

Any of these can be selected by clicking on the Drop 
Box icon of the Font Type Drop Box. Move your cur-
sor down the list until you find the desired font and 
click it.  

Special symbols are found under a variety of head-
ings, the best known being Wingdings: 
(+P8-=zAa. Also try out Webdings or Sym-
bols.  Additional font types can be downloaded from 
the web. 

You can change the font size in a similar way by 
using the Font Size Drop Box and selecting one of 

the default sizes. You can also enter any number directly in the box, allowing you to specify 
fractional font sizes (e.g. 12.5) or very large sizes (e.g. 400). Font sizes are measured in 

points. A 30-point font is 1 centimetre high. Examples of sizes are 5 10 15 and 20 points. 

Applying Basic Font Effects 
In addition, you can apply various formatting effects to most fonts. The 
most commonly used styles are available from the formatting toolbar: 
bold, italics and underline.  You can also use the short-cut keys <Ctrl>-

B, <Ctrl>-I and <Ctrl>-U respectively.  Of course, any COMBINATION of effects is also 
possible.  
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Exploring More Advanced Font Effects 
A wide variety of additional styles and 
special effects is available. Access the 
full range of font options by highlight-
ing (selecting) the text to which you 
would like to apply and then choosing 
the Font option from: 

• the top Format menu 

• the right-click menu 

The following are some sample text effects: 

• Subscript   

• Superscript   

• sshhaaddooww   

•    

• eeemmmbbbooosssssseeeddd      

• eeennngggrrraaavvveeeddd        

• SMALLCAPS   

• strikethrough   

• and more.   

A useful effect is the Highlight effect, that changes the background 
colour of the selected text. It is used to create “reverse text” effects 
(white text with a black highlight) or the “marker highlight” effect using 
a bright yellow or light green/blue/grey. If you have a colour printer, 
you will also want to experiment with the various font color options. 

In fact, you can even have animated fonts, such as Las 
Vegas Lights or Marching Ants, although these will obvi-
ously only have their full impacts when viewed on-
screen. Go and experiment! 
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Formatting Paragraphs 
Certain types of formatting apply to para-
graphs only. On the Format menu., click 

Paragraph to 
open the Para-
graph format 
window, from 
which most 
paragraph for-

mats can be selected. 

You can select a paragraph format before 
you start typing a new paragraph, so that 
it will apply to the new paragraph (and any 
subsequent paragraph you type until you 
change the format again). Alternatively, 
you can apply a format to an existing 
paragraph by clicking anywhere on the 
paragraph and selecting the paragraph 
format; there is no need to highlight or select the entire paragraph. Note that, due to space 
limitations, the Tab or the Borders and Shading commands will not be discussed in this 
module. 

Alignment 
Paragraphs alignment refers to the position of the paragraph in 
relation to the left and right margins. The alignment is selected by 
clicking the paragraph alignment buttons on the formatting toolbar 

and can be one of the following. 

Left aligned i.e. flush with the left page margin  
(click the Left Align Icon or press <Ctrl>-L), 

Centred (by clicking the Centre Icon or 
pressing <Ctrl>-E), or finally they can be 

right aligned i.e. flush with the right margin 
(by click the Right Align Icon or pressing <Ctrl>-R) 

Fully justified text is flush with both the left and right page margins since Word will automati-
cally insert extra white space between words to produce straight text edges on both sides. 
Although it looks more professional (just like typeset books), it is not as easy to read.  
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Line Spacing 
You can set the spacing between the lines of a paragraph. A line spacing of 1 corresponds 
to single spaced text (<Ctrl>-1) i.e. normal text without any extra space 
between lines.  

Double-spacing (<Ctrl>-2 i.e. a line spacing of 2) inserts an "empty" line 

between lines of text. The current paragraph is double-spaced. The for-

matting toolbar also has a special line spacing button (see right). 

You can also specify any other fractional part using the Format Paragraph 
menu. Line spacing of 0.8 will move lines very close to each other as in 
the current paragraph whereas a line spacing of 1.5 will leave half of a blank line between 
text lines. You can also set additional spacing between paragraphs.  

Indenting Paragraphs 
To move text away from the left margin by (one or more) <Tab> 
stops, called indenting, click the Increase Indent and Decrease Indent buttons on the for-
matting toolbar. Additional indent options available from the Format Paragraph menu are to 
indent the entire paragraph but not the first line or the Quotation Indent, which indents a 
paragraph both from the left and the right-hand margin. 

Numbered and Bullet Lists 
If you wish to make a list of a number of items, consider using a bullet list. Click on the Bul-
lets button when you type the first list item and Word will automatically insert bullets for every 
list item whenever you press <Enter>. You return to normal (body) text by clicking the Bul-
lets button again or pressing <Back Space> after your last <Enter>. If your list items are in 
a particular order or sequence, use the Numbering button instead.  

Using styles 
The recommended way of formatting your document is by 
means of styles. A style assigns a consistent, predefined set of 
formats to a paragraph based on the nature of the paragraph: 
a heading, a quote, main text, a footnote etc... As an example, 
you may want to format all your first (top) level headings with a 
20 point Arial italic font in blue on green background with a 
right alignment. Create a style by selecting Styles and For-
matting from the Format menu and the appropriate task pane 
will open. The easiest way is to first create a paragraph that 
looks the way you want it to be and then apply the paragraph formatting to the style tem-
plate. For subsequent paragraphs, you apply the style using the style drop-down box, the 
task pane or shortcut keys (e.g. <Ctrl>-<Alt>-2 for a second-level heading). 
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Page Layout 
Word allows you to customize your page layout to the finest detail. Most page formatting can 
be done by selecting  Page Setup from the File menu, though page numbering and head-
ers/footers are found on other menus.  

Page Size and Orientation 
Click the Paper Tab on the Page Setup window to specify which size of 
paper you will be using.  A common problem occurs when moving a 
document from a PC with a dot-matrix printer to a PC with 
a laser printer or vice versa: dot-matrix printers normally 
use tractor-feed continuous paper (11 inches long and 8 
inches wide) whereas laser printers use A4 cut paper 
sheets (29.7 cm or ±11.69 inches long and 21 cm wide). 
Word may change your page layout, or your document 
may print out incorrectly. Another Page Setup option is 
the orientation: landscape (“horizontal”) or portrait (“ver-
tical”). This can be specified on the Margins tab on the Page Setup win-
dow. 

Page Margins 
Page margins are the white space or borders around the main 
text on a printed page. Select the Margins Tab on the Page 
Setup window to specify the top, bottom, left and right margins. 
You can specify separate margins for the header and footer. 
Note that Word may increase your margin settings if your printer 
needs wider margins to “grip” the page. Margins are always 
specified in relation to their side of the paper e.g. the right mar-
gin equals the distance between the right border of the text and 
the right edge of the paper. You can also adjust the page mar-
gins by dragging the margin marker on the ruler bar.  

Headers and Footers 
Headers/footers are lines of text (or graph-
ics) that appear recurrently at the 
top/bottom of each page. You can specify 
the text of the header or footer by selecting 
Header and Footer on the View menu. 
(Personally, I have never understood why 
Microsoft put it there.) You can edit your 
header or footer directly in the document 
screen if you are in Print Layout view 
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mode. You can also change headers and footers within the document or specify different 
headers/footers for even and uneven pages. The header/footer can also include a variety of 
special “variables” such as page numbers, total pages in the document, date, time or file-
name. 

Page Numbering 
If you just want to number your pages, you 
can select the Page Numbers … option from 
the Insert menu. Although you can insert a 
page number also as part of the header / 
footer, the Page Number window allows you 
much more advanced control of the page 
number format. 
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Printing Your Document 
Printing a document is done the same way in most Windows XP applications.  

Printing an Entire Document 
If you want to print your entire document, without changing any settings, just click 
the Print button on the standard toolbar. (Just hover your cursor for two seconds 
above the Print button and a message will show which is your default printer.) 

Word will print your document in the background, so that you can go straight back to your 
editing work. The status bar shows the progress 
of the printing job and you can right-click the little 
printer icon on the taskbar to check the status of 
your printing job – or cancel it. 

Before printing a large job, you are ad-
vised to take a print preview so that 
you see what the final document will 

look like. Click the Print Preview button on the 
standard toolbar and Word will display a full-page 
preview of your document. You can move the 
cursor over the document (where it will change 
into a magnifying glass) to zoom in.  

Alternatively, you can preview several pages at 
once on your screen.  

Also very useful is the shrink to fit option, which 
automatically adjusts the document size to re-
duce the number of pages by one – great if e.g. 
you want to reduce a three-page document onto 
one double-sided sheet. 

Click on the Close Preview button to go back to editing your document. 

Shrink to fit 

Magnify Back to edit mode 
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Some Print Options 
The screen shot below explains the most important printing options. Note that you can get a 

detailed explanation of any option by clicking the Question Mark button on the title bar and 
then clicking the text of the option you want explained. 

Printing Selected Pages 
If you only want to print out part of a document, select the Print option from the File menu or 
press the <Ctrl>-P keyboard shortcut. You can specify the exact pages you wish to print by 
giving a page range (e.g. 5-12 means pages 5 to 12) or several page ranges separated by 
commas. If you want to print out a selected area of your document, select the area first and 
then call up the Print window. This window also allows you to print several copies of your 
document, collated (i.e. page order) or not.  

Selecting a Printer 
Normally your printer will be set up for you during the Windows XP installation process or 
when you log in to your network. Occasionally, you may need to change printers. You can 
select another printer or change the current printer settings via the Print window, or by se-
lecting Settings from the start menu.  

 

Click here to select 
another printer 

Select one or 
more copies 

Print multiple 
pages per sheet 

Print only the text that 
was selected before 
opening this window 

Print entire 
document 

Print a certain 
range of pages 
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Using Tables, Clip-Art and Pictures 
One of the greatest strengths of Word is the ease with which it handles more advanced word 
processing tasks. These will only be mentioned briefly below, but you are invited to check 
them our more thoroughly. Each feature has many options and commands for you to ex-
plore. The only way to learn about them is to try them out and experiment with the various 
options. As you start using them, you will slowly get to know them better as you seek for bet-
ter or quicker ways to accomplish various tasks. Also don’t forget to use the Help function 
when you are stuck! 

Inserting Tables 
Tables are a grid-like structure consisting of rows and col-

umns. They can have a great many different ap-
pearances and are highly customisable. Word will 
even calculate totals. To insert a table, click the 

Insert Table button on the standard toolbar. To customize the table, use 
the Table menu. 

Using Clip-Art and Pictures 

 

Make your documents even more attractive by incorporating attractive 
clip-art: ready-made graphics, pictures and drawings. Word comes with 
an attractive collection of clip-art (though your particular system installa-
tion may not have made them available). Much more clip-art and a vari-
ety of pictures can be found with commercial software or on the Inter-
net. To insert clip-art like the stick figure on the right, use the Insert Pic-
ture Clip Art/From File command, depending you wish to insert clip art 
from the standard Microsoft clip art library or your own. 

Inserting Diagrams 
There are many other graphics 
creation tools available in Word. 
You can select them from the Picture sub-menu on the Insert 
menu, or from the drawing toolbar. Some of the chart types that 
are available (see left) are: organisation charts, cycle (process), 
radial, pyramid, Venn diagram and target diagram 
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Using WordArt and AutoShapes 
In addition to clip-art and pictures, you 
can create your own drawings with 
Draw. Just click on the Drawing but-

ton, which will make the drawing toolbar avail-
able.  

A useful option is AutoShapes, a collection of pre-
made drawings such as lines, flowcharts or call-
outs.  

 

 

 

 

 

You may also be interested in the WordArt which allows 
you to stretch, deform, shape and generally have fun with 
any text. 

 

 

I am a 
call-out 
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Using Word Processing Tools 
Perhaps the most powerful features of Word, or any Windows word processor for that mat-
ter, are their language tools that come bundled with the software. In fact, these tools should 
perhaps have been introduced right at the beginning of this document! They are all available 
from the Tools menu, though some are constantly watching “over your shoulder” to help you 
out. 

Spell-checking  
Word includes a large spelling dictionary and can be configured so 
that it checks your spelling as you type. Any words not found in 
the dictionary will be underlined in red. Right-click on the 
underlined word and Word will offer suggestions as to how 
the word might be spelled.   

Closely associated with the spell-checking is the AutoCorrect fea-
ture, which will automatically correct frequently misspelled words 
as you type. For instance, if you type teh, Word will automatically 
correct it to the. AutoCorrect also checks if you start sentences with a capital letter (but not 
two)! You can even use it to turn common abbreviations into symbols e.g. (tm) becomes ™ ;  
(c) becomes © ; :-)  becomes the smiley J etc. You can add your own custom abbreviations 
(e.g. jp becomes Jean-Paul).  Also check out AutoFormat and AutoText. 

Grammar Checking 
Even more sophisticated than the 
spelling checker is the grammar 
checker. Whenever Word thinks that 
something is grammatically not well-
formed, it will underline the text 
(usually a sentence) with a green 
wavy underline. It may suggest a 
correction and also explain the 
grammar rule with an example. 

 

 

 

speled 
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Thesaurus Lookup 
Stuck for the right word? Use the the-
saurus by pressing <Shift>-<F7> and 
Word will quickly look up a whole lot of 
synonyms for you! Some words have 
different meanings and the thesaurus 
will offer a list of synonyms for each 
meaning. 

 

And Much, Much More … 
AutoSummarize will generate a summary of a 
document for you! If your system is configured 
with access to Microsoft Bookshelf, you can 
lookup a reference from your document di-
rectly (and paste the reference material back 
in your document).  

With Mail Merge you can customize the con-
tent of your letters or other documents to a 
large number of individuals.  

Wit
h 
Vis
ual 

Basic, you can even develop your own program within Word for unlimited customisation.  

Word will take you wherever you want to go!  
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Exercises 

Exercise 1 
1. Type all of the text given in the example below using Verdana font in 16 point size. 
2. The greeting “Calling all Friends!” should appear in the centre of the first line. 
3. The greeting should be in italics and bold and underlined. 
4. All text should be fully justified, i.e. flush with both the right and left margins. 
5. Insert a page number automatically in the centre, at the bottom of the page 
6. Indent and bullet the four activities. 
7. Use page margins of 6 centimetres on the left and 2 centimetres on the right. 
8. Note: you will get one mark for word-wrapping. 
9. Correct the four spelling mistakes by using the Spell Checker tool. 
9. Insert the DANGER N symbol after the word “beware” from the Wingdings font by typing 

N 
10. Save your note in the My documents folder under the name GOALS 
 

Calling all Friends! 
 
I want to be the best student on U.C.T 
Campus.  
 
When I arrived at the University I found 
it diffiult to settle down as I was al-
ways: 
 
• going to parties,  
• watching movies,  
• drunking and 
• meeting girls. 
 
I have now decided that I want a first 
and I want my name to appear on the 
Dean’s Merit List. I know that I have a 
great deal of work ahead of me, but I 
am determinned and believe in my abil-
ity. Frinds beware   N    leave me to 
work. 
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Exercise 2 
1. Type the text given in the example below using Comic Sans MS font in 16 point size. 
2. Bold the word “Bolding”. 
3. Underline the word “Underlining”. 
4. Bullet the four points. 
5. Indent the four points. 
6. All text should be fully justified, i.e. flush with both the right and left margins. 
7. Use page margins of 5 centimetres on the left and 5 centimetres on the right. 
8. Note: you will get one mark for word-wrapping. 
9. Correct the four spelling mistakes by using the Spell Checker tool. 
10.Insert the page number at the bottom of the page, on the left. 
11.Insert the CLOCK ¹ symbol after the words “starts at” from the Wingdings font. 
12.Save your note in My documents folder under the name “Granny”. 
 

 

Dear Granny 
 
In Infomation systems we have to learn word 
procesing skills. I thought I would write to you and 
praktice what I have learned: 

• Bulleting, 
• Indenting, 
• Underlining and  
• Bolding 
 
I have also learned to manipulate the size of my 
document by changing the line spacing - no more 
strugling to make my essay three pages when I only 
have two pages worth of information - cool hey? 
 
Anyway I need to go as my lecture starts at ¹. 
 
Love  
(Your Name) 
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Exercise 3 
1. Type all of the text given in the example below using Arial in 16 point size. 
2. The headline “Wanted” should appear in the centre on the first line. 
3. The headline should be in bold and italics. 
4. Put a “box” around the headline. 
5. All text should be fully justified. 
6. Insert the file name automatically in the centre at the top of the page. 
7. Use page margins of 6 centimetres on the left and 6 centimetres on the right. 
8. Note: you will get one mark for word-wrapping. 
9. Use a numbered bullet list for the “Four students who are required to” list. 
10. Correct the four spelling mistakes by using the Spell Checker tool. 
11. Insert the phone symbol ( before the number from the Wingdings font by typing (. 
12. Save your note in My documents folder under the name DESIRE. 
 
 

 
                         WANTED                       .  

 
A researcher at U.C.T. is seeking help with 
obtaining data from idustry. 
 
Four students are required who: 
1. are fit 
2. have spare time 
3. are able to visit small businesses in vari-
ous parts of town 
 
A questionaire will be provided and traning 
given to these students. 
 
Pay is at normal reseracher assistant 
rates. 
 
Contact me at ( 123-4567. 
 
(type your own name here) 
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